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SHIPCONSTRUCTOR LICENSE AGREEMENT 

USE OF SHIPCONSTRUCTOR SOFTWARE REQUIRES ACCEPTANCE OF THE FOLLOWING LICENSE AGREEMENT. 

1. License Grant. ShipConstructor Software Inc., #304 – 3960 Quadra Street, Victoria, B.C. Canada, V8X 4A3 (“SSI”) grants to 

the person accepting this Agreement (the “Licensee”) a non-exclusive, non-transferable right to use (the “License”) in 

object code form those program modules, application programming interface (“API”), any other materials provided by 

SSI under this Agreement, and all upgrades, revisions, fixes, updates or enhancements to any of the foregoing (“Licensed 

Materials”) specified in the Licensee’s purchase order or request (“Invoice”) solely on the software and hardware listed in 

the Licensed Materials manual (“System Configuration”). 

2. Academic Institutions/Trial Versions. 

A. In the event that the Licensee qualifies as an academic institution user in accordance with SSI’s specifications (an 

“Academic Licensee”), the Academic Licensee and its faculty, employees and students may use the Licensed 

Materials for the singular purpose of either teaching, training users or undertaking research provided that the 

Licensed Materials, and all copies of the Licensed Materials, remain at all times at the Academic Licensee’s premises 

and the Licensed Materials are used for no other purpose than that set forth above. The above restrictions are in 

addition to the restrictions on use set out in Section 5 below. 

B. In the event that the Licensee receives a trial version of the Licensed Materials for evaluation purposes, the terms 

and conditions of this Agreement, excluding Sections 15-19, shall continue to apply subject to the following 

provisions: 

(a) the License pursuant to Section 1 above shall terminate at the end of the specified trial period; 

(b) the Licensee shall return the Hardware Key to SSI immediately upon expiry of the specified trial period and in 

any event within 28 days of the expiry of the specified trial period; 

(c) in the event that the Licensee does not return the Hardware Key in accordance with Section 2B.(b) above, SSI 

shall be entitled to invoice the Licensee for and the Licensee shall pay for the costs of the Hardware Key plus all 

shipping and handling expenses and SSI administrative charges; and 

(d) in the event that the Licensee elects to and does acquire a License, the terms and conditions of this Agreement, 

excluding Section 2B herein, shall continue on and apply. 

3. Ownership. All rights, title and interests in and to the Licensed Materials and related documentation shall remain the 

sole property of SSI. Licensee shall not remove or alter any proprietary rights notices on the Licensed Materials and the 

documentation, and shall reproduce such notices on any copies that it makes. Licensee shall be liable for the security of 

the Licensed Materials and the documentation in its possession. 

4. Expertise Required. Licensee is responsible for evaluating whether the Licensed Materials meets Licensee’s requirements, 

and for operating the Licensed Materials and the results obtained. The Licensed Materials are intended for ship modeling 

and construction purposes only, and must be used by a person who has expertise and knowledge in this field. The 

Licensed Materials requires independent confirmation of the reliability and accuracy of all designs, drawings and other 

Licensed Materials output. An SSI representative may be made available under a separate consulting agreement, as the 

Licensee’s request to provide training and consultation on the operation or integration of licensed materials. 
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5. Limitations on Use. 

Licensee shall: 

A. not make more copies of the Licensed Materials than are necessary for the Licensee’s installation of the Licensed 

Materials and shall only create backup copies for archival or emergency restart purposes; 

B. maintain a log of the number of and location of all originals and copies of the Licensed Materials; 

C. include SSI’s copyright, trademark and proprietary notices on any complete or partial copies of the Licensed 

Materials in the same form and location as the notice on any original work; 

D. not attempt to defeat any copy protection; 

E. not modify, any documentation, including any user manuals; 

F. not modify, translate, reverse engineer, decompile or disassemble the Licensed Materials; 

G. not sublicense, transfer, assign, sell, loan, rent or lease the Licensed Materials other than as permitted in this 

Agreement; 

H. use the Licensed Materials for its own internal use only; 

I. not permit any third party to use the Licensed Materials; and 

J. thoroughly test any and all custom interfaces in accordance with general engineering principles. 

6. Delivery and Installation. All Licensed Materials will be delivered in an electronic format by media or method as SSI may 

elect and will be sent to the Licensee’s designated email address or shipping address as specified in the Invoice. Licensee 

agrees to be responsible for installation of the Licensed Materials. 

7. Term of License. The License term commences on the delivery of the Licensed Materials to the Licensee, and, subject to 

Section 2B above, is either perpetual if so requested on the Order, or on a month to month rental or lease basis. If Licensee 

chooses a lease option the license converts to a perpetual term on Licensee’s payment of the balance of the perpetual 

License fee (prior monthly payments receiving 80% credit). All Licenses are subject to termination in accordance with this 

Agreement. 

8. System Configuration. Operation of the Licensed Materials requires use of the specified System Configuration, which 

Licensee shall acquire and implement. SSI shall not be responsible for any operational problems caused by the System 

Configuration. 

9. Hardware Keys. Licensed Materials use requires “Hardware Keys” supplied by SSI, which can be used only at the site(s) 

authorized by SSI. In the event of a failure of the Licensee’s System Configuration, the Licensee may upon advising SSI 

use the Hardware Keys and Licensed Materials on another system and/or location. 

10. License Fees. Licensee shall pay to SSI the License fees applicable for the Licensed Materials as set out in and in 

accordance with SSI’s Invoice.  

11. Services. Support services after the Warranty Period (as defined in Section 15 below) are provided by SSI under the terms 

of the SSI Subscription Agreement. Installation, consulting, training and implementation services, if requested by the 

Licensee, shall be provided by separate agreement and at an additional charge. 
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13. Taxes. All amounts payable by Licensee to SSI are exclusive of all commodity taxes, including but not limited to 

applicable sales, use, value added, custom duties, excise taxes and other similar government charges, all of which will be 

paid by Licensee. If Licensee is required by law to withhold any taxes, then Licensee shall pay SSI a gross amount of 

money such that the net amount received by SSI after deducting or withholding the required taxes is equal to the amount 

of the fee originally charged by SSI. 

14. Interest Charges. If any amount payable under this Agreement is not paid within 30 days of becoming due, SSI shall have 

the right to impose a charge of 2% per month (24% annually) on the unpaid balance of the amount, from the due date 

until the date of receipt of all amounts in arrears including interest. 

15. Purchase Orders. Any purchase order (an “Order”) delivered by Licensee shall at all times be deemed to incorporate this 

Agreement by reference and shall be subject to the applicable provisions of this Agreement. Any provisions of an Order 

shall not apply and shall not be binding upon SSI unless they relate to information which was requested by SSI. In the 

event of a conflict or an inconsistency between the provisions of an Order and the terms and conditions of this 

Agreement, this Agreement shall govern and supersede to the extent of such conflict or inconsistency. 

16. Limited Warranty. SSI warrants that during a period of 90 days from the date of delivery of the Licensed Materials to 

Licensee (the “Warranty Period”), the Licensed Materials will perform substantially in accordance with the Licensed 

Materials documentation specifications, when used in accordance with this Agreement on a properly operating System 

Configuration. SSI’s sole obligation under this Warranty, and Licensee’s exclusive remedy, shall be to use reasonable 

commercial efforts to correct Errors (a bug, defect or other problem incurred by a user in operating the Software that 

prevents the Software from performing in a manner consistent with the applicable specifications set out in the User 

Manual) that the Licensee identifies to SSI through fixes or workarounds free of charge. If SSI determines that it is unable 

to make the Licensed Materials perform substantially as warranted, Licensee may terminate the License and receive a 

refund of a portion of the License Fees paid to date. 

17. WARRANTY EXCLUSIONS. THE LIMITED WARRANTY CONTAINED IN SECTION 15 IS IN LIEU OF ALL OTHER 

WARRANTIES, EXPRESS OR IMPLIED. ALL OTHER CONDITIONS, WARRANTIES, AND REPRESENTATIONS, 

EITHER EXPRESS OR IMPLIED, ARE EXCLUDED, INCLUDING BUT NOT LIMITED TO CONDITIONS, 

REPRESENTATIONS AND WARRANTIES RELATING TO MERCHANTABILITY AND FITNESS FOR A PARTICULAR 

PURPOSE. SSI DOES NOT WARRANT THAT THE LICENSED MATERIALS ARE COMPLETELY ERROR FREE OR 

THAT ITS OPERATION WILL BE CONTINUOUS AND UNINTERRUPTED.  

18. Maintenance Services. Licensee may elect, at the expiry of the Warranty Period, to obtain maintenance, support and 

upgrade services from SSI in accordance with and subject to the terms of SSI’s standard Subscription Agreement. 

19. Loss of Data. SSI shall not be responsible for any loss of or damage to files or data caused by the Licensed Materials, or be 

required to restore or rebuild files or data. Licensee shall implementing adequate backup procedures to avoid any loss of 

files and data. 

20. Modifications. SSI may, from time to time, provide the Licensee with revisions to the Licensed Materials (the “Revised 

Licensed Materials”). The Licensee shall test any external applications using the revised API before implementing the new 

version. While it is SSI’s intention that the Revised Licensed Materials shall be backward-compatible with the 

immediately prior version of the Licensed Materials, SSI does not guarantee or warrant that this shall be so, and SSI shall 

have no liability whatsoever to the Licensee for any failure of the Revised Licensed Materials to be backward compatible 

with any prior version of the Licensed Materials. Modifications requested by the Licensee shall be subject to prior written 

agreement as to scope and fees payable. Ownership of all Licensed Materials modifications shall vest in SSI. SSI does not 

warrant, guarantee or otherwise commit to supporting Licensed Materials that has been superseded by Revised Licensed 

Materials. 
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22. Confidential Information. Each party will not use the confidential information of the other party for any purpose except 

for the purpose described in this Agreement, and shall not disclose it to any other person except on a confidential basis to 

its employees and representatives who have a need-to-know the confidential information for such purposes. This Section 

23 shall not apply to confidential information which (a) is or has become readily available to the public in the same form 

other than by an act or omission of the receiving party, (b) was lawfully obtained in the same form by the receiving party 

from a third party not under an obligation of confidence to the disclosing party, (c) was in the receiving party’s possession 

in the same and material form prior to its receipt from the disclosing party and did not otherwise originate from the 

disclosing party, or (d) is required to be disclosed by operation of law. 

23. Termination. This Agreement may be terminated by either party, immediately by written notice, if the other party 

commits a breach of any material provision of this Agreement, including a failure to make payment when due, and fails 

to correct or rectify such breach within 30 days of receipt of the notice requesting it to do so. SSI shall be entitled to place 

time-lock devices and other disabling features in the Licensed Materials that become effective in the event that the 

Licensee has failed to comply with its payment obligations hereunder and as set out in SSI Invoices. 

24. Effect of Termination. Upon termination of this Agreement Licensee shall immediately cease using the Licensed 

Materials, and within 14 days of termination return all Hardware Keys to SSI. 

25. CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL SSI BE LIABLE FOR ANY LOSS OF DATA OR PROFITS, 

ECONOMIC LOSS OR SPECIAL, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES WITH 

RESPECT TO THIS AGREEMENT OR THE LICENSED MATERIALS, HOWEVER CAUSED, EVEN IF SSI HAD OR 

SHOULD HAVE HAD ANY KNOWLEDGE OF THE POSSIBILITY OF SUCH DAMAGES. 

26. DAMAGES LIMITATION. THE MAXIMUM LIABILITY OF SSI FOR ALL CLAIMS AND DAMAGES OF ANY KIND, 

WHETHER FOR FUNDAMENTAL BREACH OR ANY OTHER CAUSE UNDER THIS AGREEMENT, SHALL BE 

LIMITED IN THE AGGREGATE TO THE TOTAL OF ALL FEES PAID BY LICENSEE. 

27. LIMITATION OF NON-APPLICABILITY. IN SOME JURISDICTIONS THE EXCLUSION OR LIMITATION OF 

WARRANTIES OR LIABILITY MAY NOT BE APPLICABLE, AND IN SUCH JURISDICTIONS SSI HEREBY LIMITS ITS 

LIABILITY TO THE FULLEST EXTENT PERMITTED BY LAW. 

28. Applicable Law. This Agreement shall be subject to and construed in accordance with the laws of the Province of British 

Columbia, Canada, excluding its conflict of laws rules and the application of the UN Convention on Contracts for the 

International Sale of Goods. 

29. References. SSI shall be allowed to incorporate Licensee’s name in SSI’s customer reference list and to use it for 

marketing. 

30. Dispute. If any dispute arises under this Agreement, a good faith attempt to resolve the dispute will be made by senior 

management of both parties at a mutually agreeable site and time. If the parties are unable to reach agreement within 30 

days after a request for such meeting, the dispute shall be referred to arbitration in English, before one arbitrator in 

Victoria, British Columbia, Canada, in accordance with the Commercial Arbitration Act of the British Columbia.  

31. Entire Agreement. This Agreement contains the entire agreement between the parties and shall supersede all prior 

discussions and agreements between the parties regarding its subject matter. 

32. Amendment. Any amendment of this Agreement must be in writing and signed by duly authorized representatives of 

the parties. 

33. Waiver. The waiver by any party of a breach by the other party of this Agreement shall not be construed as a waiver by 

such party of any succeeding breach by the other party of the same or another provision. 
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35. Assignments. Licensee may not assign or transfer the License or Licensee’s rights or obligations under this Agreement 

without SSI’s prior written consent, and any such assignment or transfer without consent shall be null and void. A 

transfer of all or substantially all of the voting stock of the Licensee shall constitute a transfer for these purposes and shall 

be subject to SSI’s prior written consent. 

36. Successors and Assigns. This Agreement will bind and enure to the benefit of the parties and their respective successors 

and permitted assigns. 

37. Severability. In the event that any provision of this Agreement is declared invalid, illegal or unenforceable by a court 

having jurisdiction, then the remaining provisions shall continue in full force and effect.Force Majeure. Except as related 

to Licensee’s obligation to make payments to SSI, neither party shall be liable for delays or non-performance if such 

delays or non-performance are beyond such party’s reasonable control. A delayed party shall promptly notify the other 

party in writing stating the cause of the delay and its expected duration and shall use commercially reasonable efforts to 

remedy a delay or non-performance as soon as reasonably possible. 

38. Survival. The provisions of Sections 3, 5, 10, 12, 13, 16 and 18-28 shall survive the expiry or termination of this 

Agreement. 

39. Language. It is the express will of the parties that this Agreement and related documents have been prepared in English. 

C’est la volonté expresse des parties que la présente Convention ainsi que les documents qui s’y rattachent soient rédiges 

en anglais. 
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System Requirements 

A ShipConstructor implementation consists of the following software components: 

 ShipConstructor client software 

 ShipConstructor server tools – Tools for providing licensing and administering project databases on Microsoft SQL Server. 

 Microsoft SQL Server – One network accessible instance is required to host ShipConstructor project databases. 

It is recommended that the server hosting the ShipConstructor project database be hosted on a separate machine from the 

ShipConstructor client. Standalone installations are only recommended for a single-user environment.  

ShipConstructor Software Requirements 

Client/Standalone Installations 

Windows 

ShipConstructor 2012 client and server installations are compatible with the following operating systems: 

 Windows XP SP2 or later (32-bit) 

 Windows Vista (32-bit and 64-bit) 

 Windows 7 (32-bit and 64-bit) 

.NET Framework 

Prior to installing any ShipConstructor software, Microsoft .NET 3.5 SP1 must be installed. Microsoft .NET 3.5 SP1 Framework is freely 

available from Microsoft. 

AutoCAD 

Prior to installing the ShipConstructor 2012 client software, AutoCAD 2010, 2011, or 2012 must be installed on the client machine. 

ShipConstructor 2012 is compatible with AutoCAD, AutoCAD Mechanical, and AutoCAD Electrical. ShipConstructor server tools, 

ShipCam and NC-Pyros are not dependent on AutoCAD. 

ShipConstructor 2012 can be installed side-by-side with ShipConstructor 2011, 2009, 2008, or 2005. However, multiple 

ShipConstructor installations cannot share the same version of AutoCAD. The ShipConstructor 2012 installer will detect existing 

installations of ShipConstructor and prevent ShipConstructor 2012 from being installed on an AutoCAD instance that is already in 

use.  

  

Important: A hardware lock is required to run ShipConstructor products. Without the hardware 

lock, all products will run with limited functionality. 

Note: The ShipConstructor 2011 installer does NOT detect existing installations of ShipConstructor; 

installing ShipConstructor 2011 AFTER installing ShipConstructor 2012 on the same instance of 

AutoCAD is not supported and will cause ShipConstructor 2012 to stop working. 
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Server Installations 

Windows 

ShipConstructor 2012 server installations are compatible with the following operating systems: 

 Windows Server 2008 (32-bit and 64-bit) 

 Windows Server 2008 R2 (32-bit and 64-bit) 

 Windows Server 2003 (32-bit) 

.NET Framework 

Prior to installing any ShipConstructor software, Microsoft .NET 3.5 SP1 must be installed. Microsoft .NET 3.5 SP1 Framework is freely 

available from Microsoft. 

Standalone and Server Installations 

Microsoft SQL Server 

All ShipConstructor 2012 implementations require at least one instance of Microsoft SQL Server installed.  

A free licensed version of Microsoft SQL Server 2005 Express Edition SP3 is packaged with ShipConstructor 2012. However, for larger 

projects (5 or more users) a full 64-bit version of MS SQL Server 2005 SP3, SQL 2008 or SQL 2008 R2 is recommended to overcome 

limitations. 

A full version increases the amount of RAM and the number of CPUs that can be used. A 64-bit installation of Microsoft SQL Server 

running on a 64-bit operating system also increases performance due to larger system bus bandwidth and the ability to natively 

address larger amounts of memory. This is crucial for servers hosting many projects or projects of large size. 

Server Hosting Recommendations 

There are three categories of items that must be served to support a ShipConstructor project: project databases; project drawing 

files; and software licenses. In all but enterprise implementations it is recommended that all three components be hosted on the 

same server hardware to reduce setup and administrative overhead. It is also recommended that all projects be kept on the same 

project server to make administration tasks easier. 

  

Note: SQL 2000 is no longer supported in ShipConstructor 2012. 

Important: It is possible to restore a database created in an older version of SQL Server into a 

newer version of SQL Server. However it is not possible to restore a database created in a newer 

version of SQL Server into an older version of SQL Server. For this reason, the SQL Server version 

used by any partner offices or subcontractors should be considered when choosing the SQL Server 

version to use. 
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Server Hardware Requirements 

These specifications are recommended for satisfactory performance. Specifications better than those outlined below can offer better 

performance. 

ShipConstructor 

Number of Users CPU RAM (GB) Disk Configuration Disk Space (per project) 

1-5 Intel® Core i5 650 @ 

3.2Ghz or better 

 

4 Single Disk or RAID 1 

using high performance 

SATA disks 

5 

5 – 10 Intel® Xeon® 

Processor X3470 (8M 

Cache) @ 2.93Ghz or 

better 

 

8 3 Disk RAID 5 or 4 Disk 

RAID 10 using high 

performance SATA 

disks 

5 

10 – 20 2 X Intel® Xeon® 

Processor X3470 (8M 

Cache) @ 2.93 GHz or 

better 

 

16 RAID 1 for Operating 

System and SQL Server 

binaries 

3 Disk RAID 5 or 4 Disk 

RAID 10 for SQL Server 

databases and 

ShipConstructor project 

files 

Disks should be high 

performance SATA or 

SAS disks 

10 

>20 Contact ShipConstructor for recommendations 

Client/Standalone Hardware Requirements 

ShipConstructor 

ShipConstructor 2012 Recommended Client Hardware Specifications 

CPU RAM (GB) Graphics Card* Disk Space (GB) 

Intel® Core i5 650 @ 3.2Ghz 

or better 

4 Any AutoCAD supported and 

recommended graphics card 

with a supported and 

recommended driver. 

5 

*For a list of AutoCAD supported and recommended graphics cards please see: www.autodesk.com/autocad-graphicscard 

NC-Pyros 

NC-Pyros Recommended Client Hardware Specifications 

CPU RAM (GB) Disk Space (GB) 

Intel® P4 2.0 Ghz or greater 0.5 0.1 

 

ShipCam 

ShipCam Recommended Client Hardware Specifications 

CPU RAM (GB) Disk Space (GB) 

Intel® P4 2.0 Ghz or greater 1 1 

 

What is a lock? 

The lock is a USB flash drive included with your licensed software. The lock plugs into your computer or server running 

ShipConstructor 2012 Server. The lock stores specific information that the individual ShipConstructor modules reference. Without a 

hardware lock the program will only run in unlicensed mode. ShipConstructor locks can be updated to allow use of additional 

modules or newer versions of the software. Locks can also be updated to extend time on leases and rentals. 

http://www.autodesk.com/autocad-graphicscard
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Installation Types 

ShipConstructor offers users multiple ways in which users can configure their installation.  Although a Standalone installation 

method is offered, it is recommended to either do a Single Server or Multiple Server installation to achieve best performance. 

Network Installation - Single Server 

A Single Server network installation follows basic client-server architecture.  

One machine houses the Microsoft SQL Server, the ShipConstructor Server files, the project database, project files and the Licensing 

Server. Workstations then communicate with the server. 

Installed on the Server: 

 ShipConstructor Administrator, for project maintenance 

 ShipConstructor License Server, for network licensing 

 ShipConstructor Server Setup, for configuring Microsoft SQL Server 

 License Utilities for License management 

 ShipConstructor Project Files 

Installed on the Client(s): 

 ShipConstructor 2012 

 Report 

 NC-Pyros 

 ShipCAM 
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Network Installation - Multiple Servers 

To optimize performance note that it may be desirable to separate the SQL Server, the File Server and the Licensing Server onto two 

or three different computers.  

Installed on the Licensing Server: 

 ShipConstructor License Server, for network licensing 

 License Utilities for License management 

Installed on the SQL Server: 

 ShipConstructor Administrator, for project maintenance 

 ShipConstructor Server Setup, for configuring Microsoft SQL Server 

Installed on the Client(s): 

 ShipConstructor 2012 

 Report 

 NC-Pyros 

 ShipCAM 

File Server 

 ShipConstructor Project Files 
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Standalone Installation 

Standalone installations are typically used in a single-user environment. In this configuration, a single machine acts as both server 

and client. In order to achieve satisfactory performance with a standalone installation, a multi-core CPU and 4GB of RAM is 

recommended. 

Note, in a multi-user environment, a network installation should be used instead of a standalone installation since performance is 

improved if server and client workload are distributed onto different computers. A network installation also allows more flexibility as 

changes to the server such as location or network drive mappings will not affect the clients. Furthermore, a network installation 

allows the project server to be replaced without any work needed on the client machines and can make it easier to work with 

multiple project servers. 

Network Installation 

Overview 

The basic process of installing ShipConstructor for a Network Installation involves the following steps: 

1. Install and/or Configure SQL Server 

2. Install ShipConstructor Server Files 

3. Install ShipConstructor Client Files 

4. Enable Licensing Server 

Install SQL Server 2005 Express on Windows XP 

1. Insert the ShipConstructor 2012 DVD into the DVD drive on the server that you wish to use for hosting SQL. The Install 

menu will Autorun.  

Note: If you have Autorun disabled in Windows or if you have downloaded the full install from the 

internet, you will need to load setup manually. 
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2. Click Install ShipConstructor 2012. The Setup Type menu will appear. 

3. Click Install Server. The ShipConstructor 2012 Server Installation menu will appear. 

4. Click Install Microsoft SQL Server 2005 Express Edition.  The SQL Server 2005 Express Edition installer will launch and 

install automatically. 

Install SQL Server 2005 Express on Windows 7, Windows Vista,  

Windows Server 2008 or Windows Server 2008 R2 

1. Insert the ShipConstructor 2012 DVD into the DVD drive on the server that you wish to use for hosting SQL. The Install 

menu will normally Autorun but it must be closed if it opens. 

2. Click the Exit button to close the Install menu if it has opened. 

3. Go to the Start menu and choose Computer to open Windows Explorer. 
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4. Right click on the DVD drive that the ShipConstructor 2012 disc is in and choose Open from the right click menu. 

5. Open the Setup folder to list the contents.  

6. Copy and paste the SQLExpress folder from the Setup folder onto your desktop. 

 

7. Open the SQLExpress folder that you just copied to your desktop. 

  



Chapter 2 

How to Install ShipConstructor 

10 

8. Edit the template.ini with your favourite text editor. 

9. Look for the line that says SAPWD=ShipCon and change ShipCon to a password that meets the security restrictions of 

your domain. 

10. Save the file and close the text editor. 

11. Launch the SQL setup process by double clicking on the SetupSQLExpress icon.  SQL will now launch and install and 

configure itself for use with ShipConstructor 2012.  

  

Note: If the password you set in Step 9 was not strong enough, you will get a warning message 

during the installation.  On the warning, click Cancel to continue the installation.  Once completed 

you will need to update the template.ini file in the folder you previously copied with a stronger 

password and rerun SetupSQLExpress. 
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Installing and Configuring All Other Version of SQL 

After installing any of the supported versions of SQL Server as per Microsoft’s instructions you will need to go through the following 

configuration steps to make SQL work with ShipConstructor. These steps will: 

 Enable TCP/IP and Named Pipes Protocols 

 Enable Remote Connections 

 Turn on the SQL Server Browser Service 

 Enable xp_cmdshell 

 Configure the Maximum Degrees of Parallelism 

Configuring SQL Server 2005 or SQL Server 2005 Express Edition (downloaded version) 

1. Go to the Start menu and under the All Programs->Microsoft SQL Server 2005->Configuration Tools menu choose 

SQL Server Configuration Manager. 

2. Under SQL Server Configuration Manager (Local), expand SQL Server 2005 Network Configuration. 

3. Select the Protocols for <Instance Name> node in the tree on the left. 

4. Right-click on TCP/IP and select Enabled. 

5. Right-click on Named Pipes and select Enabled. 

6. Under the File menu choose Exit to close the SQL Server Configuration Manager. 

Note: The following steps are only required if installing SQL Server 2005, SQL Server 2005 Express 

Edition (downloaded version), SQL Server 2008, or SQL Server 2008 R2. The version that is included 

on the ShipConstructor 2012 disc is pre-configured. 
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7. Go to the Start menu and under the All Programs->Microsoft SQL Server 2005->Configuration Tools menu choose 

SQL Server 2005 Surface Area Configuration. 

8. Click on the Surface Area Configuration for Services and Connections link. 

9. Under <Instance Name>\Database Engine\Remote Connections, select Local and Remote Connections, and Using 

both TCP/IP and named pipes. 
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10. Click Apply to save the change. 

11. Under <Instance Name>\SQL Server Browser\Service, set the Startup type to Automatic, and click the Start button to 

start the service. 

12. Click OK to save the changes and return to the SQL Server 2005 Surface Area Configuration window. 

13. Click on the Surface Area Configuration for Features link. 

14. Under <Instance Name>\Database Engine\xp_cmdshell, check the Enable xp_cmdshell checkbox. 
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15. Click OK to close the window and return to the SQL Server 2005 Surface Area Configuration window.  Close the SQL 

Server 2005 Surface Area Configuration window to complete the setup.  Your SQL Server is now ready for installation of 

the ShipConstructor Server files.  

Configuring SQL Server 2008 or SQL Server 2008 R2 

1. Go to your Start menu and choose All Programs->Microsoft SQL Server 2008->Configuration Tools and click on SQL 

Server Configuration Manager. 

2. Under SQL Server Configuration Manager (Local) expand SQL Server Network Configuration. 

3. Select the Protocols for <Instance Name> node in the tree on the left. 

4. Click on the Status for Named Pipes and change it to Enabled. 

5. Click on the Status for TCP/IP and change it to Enabled. 

6. Select SQL Server Services node under SQL Server Configuration Manager (Local) from the tree on the left. 

7. In the right side pane, right click on SQL Server Browser and choose Properties from the right click menu. 

8. In the SQL Server Browser Properties window that appears, click on the Start button to start the service if it isn’t already 

started. 

Note: You may be required to restart you server after making these changes.  Please restart before 

installing the ShipConstructor Server files to ensure that the settings are up to date. 
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9. Click OK to save the changes and close the SQL Server Browser Properties window. 

10. Under the File menu choose Exit to close the SQL Server Configuration Manager. 

11. Go to your Start menu and choose All Programs->Microsoft SQL Server 2008 and click on SQL Server Management 

Studio. 

12. Right click on the Database Server Instance that is being configured.  

13. Choose Facets from the right click menu to open the View Facets Window. 

14. Change the Facet dropdown to Server Configuration. 

15. Change XPCmdShellEnabled to True. 

16. Click OK to save the changes and close the View Facets window. 

17. In the Object Explorer section, right click on your server instance and choose properties from the right click menu. 

18. In the Server Properties window that just opened, under Select a page click on Advanced. 
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19. In the right hand pane under the Parallelism section change Max Degree of Parallelism to 1. 

20. Under Select a page click on Connections. 

21. Under the Remote server connections section, ensure that Allow remote connections to this server is checked. 
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22. Click OK to save the changes and close the Server Properties window. 

23. Close the Microsoft SQL Server Management Studio window to complete the configuration of your SQL server.  Your 

SQL Server is now ready for installation of the ShipConstructor Server files. 

Configuring Windows Firewall 

If a firewall is turned on but not correctly configured, attempts to connect to SQL Server might be blocked. If this is the case, consult 

www.microsoft.com for instructions regarding manually configuring Windows Firewall. 

Install ShipConstructor Server Files 

1. Insert the ShipConstructor 2012 DVD into the DVD drive on the server that you wish to use for hosting the 

ShipConstructor projects. The Install menu will Autorun. 

  

Note: You may be required to restart you server after making these changes.  Please restart before 

installing the ShipConstructor Server files to ensure that the settings are up to date. 

Note: If you plan to host the Licensing Server on a separate machine from the SQL Server, install 

the ShipConstructor Server Files on both machines.  On the Licensing Server, when prompted to 

run SCServerSetup, click Cancel to skip the SQL configuration steps. 

Note: If you have Autorun disabled in Windows or if you have downloaded the full install from the 

internet, you will need to load setup manually. 
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2. Click Install ShipConstructor 2012. The Setup Type menu will appear. 

3. Click Install Server. The ShipConstructor 2012 Server Installation menu will appear. 

4. Click Install ShipConstructor Server and the installer will launch. Click Next to start the install process. 

5. Click Next. The License Agreement appears. Read the agreement carefully, accept the terms, and then click Next. 
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6. You will then be presented with the Custom Setup dialog where you can add or remove features if you want to further 

customize your install although it is recommended that most users leave the default options.  

By default, the server installation method installs the ShipConstructor Server software utilities only. This software includes 

the following: 

A. ShipConstructor Administrator, for project maintenance 

B. ShipConstructor License Server, for network licensing 

C. ShipConstructor Server Setup, for configuring Microsoft SQL Server 

D. License Utilities, for license management 

7. Click Next then click the Install button to start the installation process. 

  



Chapter 2 

How to Install ShipConstructor 

20 

8. During installation, the SCServerSetup will load so that you can configure ShipConstructor to connect to your SQL 

database. On the SCServerSetup Screen, under the SQL Server Connection section, choose a Server Instance from the 

dropdown list. If you have installed the bundled SQL Server 2005 Express Edition, the SQL Server instance is listed as 

SHIPCON. 

9. Ensure that the Use Integrated Security box is checked if you are running SCServerSetup as a machine administrator 

(typical). Otherwise, enter a SQL server username and password for any user that has a sysadmin role.  

10. Verify the details in the SQL Server Configuration Section. Match the Data, Log and Backup Paths to those used by your 

SQL installation.  If you install the bundled version of SQL Server 2005 Express Edition on a 32-bit system the default paths 

will be correct. 

11. If you intend to use ShipConstructor’s Project Split and Merge functionality, check the Create ShipConPSM share box. 

  

If you do not see the desired instance in the drop-down list, ensure that the server is currently 

running and running on the same machine. If it is not, start the service then click  If the server 

name still does not appear, type it in manually.  

Note: SQL creates an account called “sa” by default during setup.  In the bundled SQL Server 2005 

Express Edition the password is “ShipCon”.  If you installed SQL Server 2005 Express Edition on a 

version of Windows other than XP, use the password you entered into the template.ini file.  For full 

versions of SQL you will need to use the password you supplied for the “sa” user during setup. 
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12. Leave the Disable SQL Authentication unchecked.   

13. Under the ShipConstructor User section, enter and confirm the user password for the ShipConstructor user that will be 

created in the database. Note this password down as it will be required to connect to any ShipConstructor project you 

create. 

14. Click Setup to have SCServerSetup perform the following tasks. 

A. Set the server’s Authentication Mode. By default it will verify that the selected instance of Microsoft SQL Server 

supports SQL Authentication. If your Microsoft SQL Server is set to Windows Authentication Only, it will change the 

setting to Mixed Mode which supports both Windows Authentication and SQL Authentication modes. 

B. Connect to the server using the specified account. 

C. Add the user ShipConstructor with the password ShipCon as a sysadmin account. 

D. Enable the xp_cmdshell stored procedure. 

E. Set the server’s default log, data, and backup folders. 

F. Create the ShipConPSM shared folder (if checked). The ShipConPSM shared folder on the server is writable by 

everyone. If security is a concern you may limit the folder’s security but it must be writable by the following users: 

(a) Local System account (or whichever account your SQL Server is running as) 

(b) Any domain user who will perform split and merge operations 

15. Click Finish to close the window and complete the ShipConstructor Server installation. You may have to restart your server 

before you can run ShipConstructor 2012. 

Install ShipConstructor Client 

1. Insert the ShipConstructor 2012 DVD into the Workstation that you wish to install ShipConstructor on. The Install menu 

will Autorun. Choose Install ShipConstructor 2012. 

Note: If SQL Authentication is disabled, your server is set to Windows Authentication Only mode 

and will be inaccessible via SQL Authentication. 

Note: You will need to have the ShipConstructor Server files installed on a computer on your 

network prior to installing the ShipConstructor client. 

Note: If you have Autorun disabled in Windows or if you have downloaded the full install from the 

internet, you will need to load setup manually. 
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2. The menu will change to the Select Setup Type menu. Click Install Client to launch the installer. 

3. Click the Next button to start the install process. 

4. Click Next. The License Agreement appears. Read the agreement carefully, accept the terms, and then click Next. 
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5. You will be presented with the AutoCAD Selection dialog. ShipConstructor 2012 can only be installed for one version of 

AutoCAD. This dialog will display all versions of AutoCAD you have installed. Select an existing compatible AutoCAD install 

for use with ShipConstructor 2012 and click Next. 

6. You will be presented with the Custom Setup dialog. By default, the client installation method installs the necessary 

components on the current workstation for ShipConstructor 2012 to run while accessing project files and databases on a 

remote server. You can add or remove features if you want to further customize your install although it is recommended 

that most users leave the default options. 
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7. Click Next. ShipConstructor 2012 is now ready to install. Click Install to begin the installation process. 

8. Once the installer has completed click the Finish button to close the installer. 

Activate ShipConstructor Licensing 

1. To ensure locks are viewable by the License Server plug the Lock(s) into the USB port(s) of the computer for hosting the 

License Server. 

2. On the License Server computer, go to your Start menu and choose All Programs->ShipConstructor Licensing and 

click on LockView to open the LockView dialog. Ensure that the locks can be viewed.  

3. On the License Server computer, go to the Start menu and choose All Programs->ShipConstructor Licensing and click 

on License Monitor. 

  

Note: If you receive the message, “Unable to View Lock”, contact ShipConstructor Software Inc. for 

technical support. 
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4. In the Server textbox select (Local Computer) and click Refresh. The Locks should appear below in the Locks Attached 

to the Server area. The license information should appear below that in the Licensed Module List. 

5. Click the Close button to close the License Server Monitor once you have verified that it is connecting to the lock 

properly. 

6. To ensure licenses are viewable by the ShipConstructor Client, on the computer hosting the ShipConstructor Client go to 

your Start menu and choose All Programs->ShipConstructor Licensing and click on License Monitor. 

7. In the Server textbox, enter the IP address or the name of the license server and click Refresh. If the License Monitor 

can connect to the lock it will display it in the Locks Attached to Server area and you will see a list of modules on the lock 

in the Licensed Module List. 

Note: If the License Monitor is unable to see your lock you may need to start the ShipConstructor 

License Server service. 
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8. Once you have verified that the client can see the License Server, click Close to close the License Monitor window. 

9. To complete the process you will need to create a new project in ShipConstructor. Go to your Start menu and choose All 

Programs->ShipConstructor 2012 and click on ShipConstructor 2012 to launch the program. 

10. From the ribbon bar choose New Project. The New ShipConstructor Project dialog will open. 

11. Click on the ... button next to the Project Folder text box then choose a folder to store your project in.  This can be on 

your computer or another computer on your network. 

12. For the Project Server choose the machine on your network that has your SQL server installed. This will be listed in the 

format <Machine Name>\SHIPCON. 

13. Under Template Project(s) put a checkmark in the Use the same template for all areas. 
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14. Under the .PRO or .XML Template File heading, click on the ... button beside Users, Settings & Ranks. Then choose 

MetricTemplate or ImperialTemplate from the dialog box. Click Open. 

15. After a few seconds you should see that all of the templates have been populated with the path and template file that you 

just chose. 
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16. In the User Name text box in the Administrator Login section, enter ShipConstructor. Then, in the Password text box, 

enter the password that you used for this user during installation. 

17. Click OK to create the project.  The project creation will take several minutes to complete. 

18. Once the New Project Created dialog box pops up press OK to close it. 

19. You will now need to connect to project that you just created. Click on the Navigator button in the ribbon to bring up 

the Register Project window. 

20. Click on the newly created project and enter ShipConstructor for the User Name. Then enter your password for the 

ShipConstructor user.  Click on Open to open the project. The Licensing window will automatically open for you. 

21. Click on the Network button to open the Network License Settings window. 

22. Click on the New button and under License Server enter the machine name or TCP/IP address of the server where your 

USB hardware lock is plugged in. 
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23. Click on OK to close the Network License Settings window and to retrieve the license information. You will return to the 

Licensing window. 

24. If your licenses have been successfully retrieved you will see all of the available acquired modules as well as their status. 

25. Click OK to close the Licensing window.  The ShipConstructor Navigator will load.  Click Close to close the 

ShipConstructor Navigator.  You have now successfully installed ShipConstructor on your network.  

  

Note: If you have other machines on your network that need to have ShipConstructor installed you 

can re-run the client installation and activate licensing steps on each machine. 
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Standalone Installation 

Overview 

The basic process of installing ShipConstructor for a Standalone Installation involves the following steps: 

1. Install and/or Configure SQL Server 

2. Install ShipConstructor Files 

3. Enable Licensing 

Install SQL Server 2005 Express on Windows XP 

1. Insert the ShipConstructor 2012 DVD into your DVD drive. The Install menu will Autorun. 

2. Click Install ShipConstructor 2012. The Setup Type menu will appear. 

3. Click Install Standalone. The ShipConstructor 2012 Standalone Installation menu will appear. 

Note: If you have Autorun disabled in Windows or if you have downloaded the full install from the 

internet, you will need to load setup manually. 
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4. Click Install Microsoft SQL 2005 Express Edition.  The SQL Server 2005 Express Edition installer will launch, install and 

configure SQL automatically for use with ShipConstructor 2012. 

Install SQL Server 2005 Express Edition on Windows 7, Windows Vista, Windows 

Server 2008 or Windows Server 2008 R2 

1. Insert the ShipConstructor 2012 DVD into the DVD drive in your computer. The Install menu will Autorun. 

2. Click the Exit button to close the Install menu. 

3. Go to the Start Menu->Computer to open Windows Explorer. 

4. Right click on the DVD drive that the ShipConstructor 2012 disc is in and choose Open from the right click menu. 

  

Note: If you have Autorun disabled in Windows or if you have downloaded the full install from the 

internet, you will need to load setup manually. 
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5. Open the Setup folder to list the contents. 

6. Copy and paste the SQLExpress folder from the Setup folder onto your desktop. 

7. Open the SQLExpress folder that you just copied to your desktop. 

8. Edit the template.ini with your favourite text editor. 

9. Look for the line that says SAPWD=ShipCon and add a 1 onto the end of ShipCon so the line reads as 

SAPWD=ShipCon1. 

10. Save the file and close the text editor. 
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11. Launch the SQL setup process by double clicking on the SetupSQLExpress icon.  SQL will now launch, install and 

configure itself for use with ShipConstructor 2012. 

Installing and Configuring All Other Version of SQL 

After installing any of the supported versions of SQL Server as per Microsoft’s instructions you will need to go through the following 

configuration steps to make SQL work with ShipConstructor. 

These steps will perform the following: 

 Enable TCP/IP and Named Pipes Protocols 

 Enable Remote Connections 

 Turn on the SQL Server Browser Service 

 Enable xp_cmdshell 

 Configure the Maximum Degrees of Parallelism 

Configuring SQL Server 2005 or SQL Server 2005 Express Edition (downloaded version) 

1. Go to the Start menu and under the All Programs->Microsoft SQL Server 2005->Configuration Tools menu choose 

SQL Server Configuration Manager. 

2. Under SQL Server Configuration Manager (Local) expand SQL Server Network Configuration. 

3. Select the Protocols for <Instance Name> node in the tree on the left. 

4. Right-click on TCP/IP and select Enabled. 

5. Right-click on Named Pipes and select Enabled. 

6. Choose File->Exit to close the SQL Server Configuration Manager. 

7. Go to the Start menu and under the All Programs->Microsoft SQL Server 2005->Configuration Tools menu choose 

SQL Server 2005 Surface Area Configuration. 

  

Note: The following steps are only required if installing SQL Server 2005, SQL Server 2005 Express 

Edition (downloaded version), SQL Server 2008, or SQL Server 2008 R2. The version that is included 

on the ShipConstructor 2012 disc is pre-configured to work with ShipConstructor 2012. 
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8. Click on the Surface Area Configuration for Services and Connections link. 

9. Under <Instance Name>\Database Engine\Remote Connections, select Local and Remote Connections, and Using 

both TCP/IP and named pipes. 
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10. Click Apply to save the changes. 

11. Under <Instance Name>\SQL Server Browser\Service, set the Startup type to Automatic, and click the Start button 

to start the service. 

12. Click OK to save the changes and return to the SQL Server 2005 Surface Area Configuration window.  

13. Click on the Surface Area Configuration for Features link. 

14. Under <Instance Name>\Database Engine\xp_cmdshell, Check the Enable xp_cmdshell checkbox. 
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15. Click OK to close the window and return to the SQL Server 2005 Surface Area Configuration window.  Close the SQL 

Server 2005 Surface Area Configuration window to complete the setup.  Your computer is now ready for installation of 

the ShipConstructor Server files. 

Configuring SQL Server 2008 or SQL Server 2008 R2 

1. Go to your Start menu and choose All Programs->Microsoft SQL Server 2008->Configuration Tools and click on SQL 

Server Configuration Manager. 

2. Under SQL Server Configuration Manager (Local) expand SQL Server Network Configuration. 

3. Select the Protocols for <Instance Name> node in the tree on the left. 

4. Click on the status for Named Pipes and change it to enabled. 

5. Click on the status for TCP/IP and change it to enabled. 

6. Select the SQL Server Services node under SQL Server Configuration Manager (Local) from the tree on the left. 

7. In the right hand side pane, right click on SQL Server Browser and choose Properties from the right click menu. 

8. In the SQL Server Browser Properties window that opened, click on the Start button to start the service if it isn’t already 

started. 

Note: You may be required to restart your computer after making these changes.  Please restart 

before installing the ShipConstructor Standalone files to ensure that the settings are up to date. 
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9. Click OK to save the changes and close the SQL Server Browser Properties window. 

10. Under the File menu choose Exit to close the SQL Server Configuration Manager. 

11. Go to your Start menu and choose All Programs->Microsoft SQL Server 2008 and click on SQL Server Management 

Studio. 

12. Right click on the Database Server Instance that is being configured. 

13. Choose Facets from the right click menu to open the View Facets Window. 

14. Change the Facets dropdown to Server Configuration. 

15. Change XPCmdShellEnabled to True. 

16. Click OK to save the changes and close the View Facets window. 

17. In the Object Explorer, right click on your server instance and choose properties from the right click menu. 

18. In the Server Properties window that just opened, under Select a page click on Advanced. 
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19. In the right hand pane under the Parallelism section, change Max Degree of Parallelism to 1. 

20. Under Select a page click on Connections. 

21. Under the Remote server connections section, ensure that Allow remote connections to this server is checked. 
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22. Click OK to save the changes and close the Server Properties window. 

23. Close the Microsoft SQL Server Management Studio window to complete the configuration of your SQL server.  Your 

computer is now ready for installation of the ShipConstructor Standalone files.  

Configuring Windows Firewall 

If a firewall is turned on but not correctly configured, attempts to connect to SQL Server might be blocked. If this is the case, consult 

www.microsoft.com for instructions regarding manually configuring Windows Firewall. 

Install ShipConstructor Standalone 

1. Insert the ShipConstructor 2012 DVD into the computer that you wish to use for running ShipConstructor. The Install 

menu will Autorun. 

2. Click Install ShipConstructor 2012. The Setup Type menu will appear. 

  

Note: You may be required to restart your computer after making these changes.  Please restart 

before installing the ShipConstructor Standalone files to ensure that the settings are up to date. 

Note: If you have Autorun disabled in Windows or if you have downloaded the full install from the 

internet, you will need to load setup manually. 
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3. Click Install Standalone. The ShipConstructor 2012 Standalone Installation menu will appear. 

4. From the ShipConstructor 2012 Standalone Installation menu click Install ShipConstructor Standalone. Click Next. 

5. The License Agreement appears. Read the agreement carefully, accept the terms, and then click Next. 
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6. You will be presented with the AutoCAD Selection dialog: ShipConstructor 2012 can only be installed for one version of 

AutoCAD. This dialog will display all versions of AutoCAD you have installed. Select an existing compatible AutoCAD install 

for use with ShipConstructor 2012 and click Next. 

7. You will be presented with the Custom Setup dialog: By default, the standalone installation method installs the entire 

ShipConstructor 2012 suite. You can add or remove features if you want to further customize your install although it is 

recommended that most users leave the default options. Click Next. 
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8. During installation, the SCServerSetup will load so that you can configure ShipConstructor to connect to your SQL 

database. On the SCServerSetup Screen, under the SQL Server Connection section, choose a Server Instance from the 

dropdown list. If you have installed the bundled SQL Server 2005 Express Edition, the SQL Server instance is listed as 

SHIPCON. 

9. Ensure that the Use Integrated Security box is checked if you are running SCServerSetup as a machine administrator 

(typical). Otherwise, enter a SQL server username and password for any user that has a sysadmin role.  

10. Verify the details in the SQL Server Configuration Section. Match the Data, Log and Backup Paths to those used by your 

SQL installation.  If you install the bundled version of SQL Server 2005 Express Edition on a 32-bit system the default paths 

will be correct. 

11. If you intend to use ShipConstructor’s Project Split and Merge functionality, check the Create ShipConPSM share box. 

  

If you do not see the desired instance in the drop-down list, ensure that the server is currently 

running and running on the same machine. If it is not, start the service then click  If the server 

name still does not appear, type it in manually.  

Note: SQL creates an account called “sa” by default during setup.  In the bundled SQL Server 2005 

Express Edition the password is “ShipCon”.  If you installed SQL Server 2005 Express Edition on a 

version of Windows other than XP use the password you entered into the template.ini file.  For full 

versions of SQL you will need to use the password you supplied for the “sa” user during setup. 
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12. Leave the Disable SQL Authentication unchecked.  

13. Under the ShipConstructor User section, enter and confirm the user password for the ShipConstructor user that will be 

created in the database. Make a note of this password as it will be required to connect to any ShipConstructor project you 

create. 

14. Click Setup to have SCServerSetup perform the following tasks. 

A. Set the Authentication Mode. By default it will verify that the selected instance of Microsoft SQL Server supports SQL 

Authentication. If your Microsoft SQL Server is set to Windows Authentication Only, it will change the setting to 

Mixed Mode which supports both Windows Authentication and SQL Authentication modes. 

B. Connect to SQL using the specified account. 

C. Add the user ShipConstructor with the password ShipCon as a sysadmin account. 

D. Enable the xp_cmdshell stored procedure. 

E. Set the SQL Server default log, data, and backup folders. 

F. Create the ShipConPSM shared folder (if checked). The ShipConPSM shared folder on the server is writable by 

everyone. If security is a concern you may limit the folder’s security but it must be writable by the following users: 

(a) Local System account (or whichever account your SQL Server is running as) 

(b) Any domain user that will perform split and merge operations 

15. Click Finish to close the window and complete the ShipConstructor Standalone installation. You may have to restart your 

computer before you can run ShipConstructor 2012. 

  

Note: If SQL Authentication is disabled, your server is set to Windows Authentication Only mode 

and will be inaccessible via SQL Authentication. 
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Activate ShipConstructor Licensing 

1. To ensure locks are viewable by the License Server Software plug the Lock(s) into the USB port(s) of your computer. 

2. Click Start and go to All Programs->ShipConstructor Licensing and click on LockView to open the LockView dialog. 

Ensure that the locks can be viewed and click Close. 

3. Go to your Start menu and choose All Programs->ShipConstructor Licensing and click on License Monitor. 

  

Note: If you receive the message, “Unable to View Lock”, contact ShipConstructor Software Inc. for 

technical support. 
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4. In the Server textbox enter (Local Computer) and click Connect. The locks should appear below in the Locks Attached 

to the Server area. The license information should appear below that in the Licensed Module List. 

5. Click the Close button once to close the License Server Monitor once you have verified that it is connecting to the lock 

properly. 

6. You now need to register the locks with ShipConstructor. Go to your Start menu and choose All Programs-

>ShipConstructor 2012 and click on ShipConstructor 2012 to launch the program. 

7. From the ribbon bar choose New Project. 

8. Choose a folder to store the project. 

  

Note: If the License Monitor is unable to see your lock you may need to start the ShipConstructor 

License Server service. 
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9. For the Project Server choose your computer. This will be listed in the format <Machine Name>\SHIPCON. 

10. Under Template Project(s) put a checkmark in the Use the same template for all areas checkbox. 

11. Under the .PRO or .XML Template File heading, click on the ... button beside Users, Settings & Ranks. Then choose 

MetricTemplate or ImperialTemplate from the dialog box. Click Open. 
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12. After a few seconds you should see that all of the templates have been populated with the path and template file that you 

just chose. 

13. Under the Administrator login section, in the User Name field, enter ShipConstructor. In the password field, enter the 

password that you used when creating the ShipConstructor user. 

14. Click OK to create the project.  The project creation will take several minutes to complete. 

15. Once the New Project Created dialog box pops up, press OK to close it. 

16. You will now need to connect to the project that you just created. Click on the Navigator button in the ribbon to bring up 

the Register Project window. 

17. Click on the newly created project and enter ShipConstructor for the User Name. Then enter your password for the 

ShipConstructor user.  Click on Open to open the project. 
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18. The Licensing window will automatically open for you.  If your licenses have been successfully retrieved you will see all of 

the available acquired modules as well as their status. 

19. Click OK to close the Licensing window.  The ShipConstructor Navigator will load.  Click Close to close the 

ShipConstructor Navigator.  You have now successfully installed ShipConstructor on your computer. 
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Modify or Remove ShipConstructor 

Remove ShipConstructor 

To remove an installation of ShipConstructor 2012 

1. Open the Control Panel. 

2. Open Add or Remove Programs. 

3. Find ShipConstructor 2012 in the list of installed applications. 

4. Click Remove. The confirmation window will appear. 

5. Click Yes to remove ShipConstructor 2012. 

To remove an installation of SSI Licensing 

SSI Licensing handles licensing for all ShipConstructor products. You should only remove this if you are removing all ShipConstructor 

products. 

1. Open the Control Panel. 

2. Open Add or Remove Programs. 

3. Find SSI Licensing in the list of installed applications. 

4. Click Remove. The confirmation window will appear. 

5. Click Yes to remove SSI Licensing. 

Modify ShipConstructor Installation 

To add or remove features from a ShipConstructor 2012 installation 

1. Open the Control Panel. 

2. Open Add or Remove Programs. 

3. Find ShipConstructor 2012 in the list of installed applications. 



Chapter 3 

Modify or Remove ShipConstructor 

51 

4. Click Change. The Installer will launch. 

5. Click Next. The following window appears.  

6. Choose Change and then click Next. You will now see the list of features that you can add or remove. 

7. Choose the features to add or remove, click Next, and then click Install. 
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Updating ShipConstructor 

It is possible to update existing installations of ShipConstructor whenever a new version is released. By doing this you can receive 

the newest enhancements without a lengthy reinstall process. If you are using ShipConstructor in a network environment the server 

and all client workstations should be updated at the same time since doing so ensures that the project databases on the server are 

in sync with the software on the client machines.  

Downloading the Update 

To download the files necessary to apply the update, visit the ShipConstructor website and find the download section. You will need 

the latest version of the update for the product you want to update.  

Applying the Update 

1. Run the update executable on the machine you want to update. The file should be named SC2012Update###.exe where 

### refers to the update version you have downloaded. The update installation initializes and the installer appears. 

2. Click Update to continue. 

3. When the update is complete, the installer shows a completed message. Click Finish to conclude the update process. 

4. You may need to reboot your computer at this time. If the Installer Information window appears, click Yes to reboot your 

machine now.  

Note: This will complete the updating of the software portion of ShipConstructor on this computer. 

After you have updated all of the machines on your network, you will need to update the project 

databases for use with the updated software. 
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Update a Project Database Version 

Each updated software release may include a new version of the ShipConstructor database. Once the update is applied, you can 

update your ShipConstructor projects to the required database version. 

To update a project database version: 

1. In Administrator, select the projects you want to update. 

2. Choose Project > Update to open the Update Project Databases window. 

3. Select the database version you want to update the projects to. 

4. Click Start. ShipConstructor automatically creates a backup of the selected projects in the default backup directory at 

<SQLDataRoot>\BACKUP\<database name><current date&time>.bak. Once the update has completed, to view a log 

file of the update, click View Log. 

5. Click Close. 

Note: Updating a project database converts a project created with a previous version of 

ShipConstructor into the newest version.  Newer project databases are not backwards compatible 

with older versions of ShipConstructor. 
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Installing the Navisworks Enabler 

If you want to view ShipConstructor drawings through Navisworks Review, Manage or Simulate, the Navisworks Enabler must be 

installed. If a Navisworks product is installed before installing ShipConstructor 2012, the Navisworks Enabler will be installed by 

default. However, if you install a Navisworks product after installing ShipConstructor 2012, you will have to modify the install to 

include the Navisworks Enabler before you can use the associated functionality. To do this: 

1. Refer to the section Modify ShipConstructor Installation (pg. 29). 

2. At the custom setup dialog, select the feature “Navisworks Enabler” and select “This feature will be installed on 

local hard drive”. 

3. Click Next, and then click Install. 

Technical Support 

ShipConstructor Software Inc. offers technical support as part of Subscription. 

Office hours: 7:00 am - 5:00 pm Pacific Time 

Toll-free: 1-888-210-7420 

Phone: 1-250-479-3638 

Fax: 1-250-479-0868 

E-mail: support@ShipConstructor.com 

Web: www.ShipConstructor.com 


